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Color us confused. Last week, Bloomberg  
Businessweek published a long, detail- 

filled story alleging that Chinese spies had compromised 
America’s technology supply chain by inserting a malicious 
chip into servers used by as many as 30 major technology 
companies, including Apple.

It’s a bombshell of an article, but an odd one, simultaneously 
specific in places while vague about what these alleged 
chips actually did. Plus, all sources were anonymous, 
which isn’t unusual for an article that involves government- 
level industrial espionage and national security, but it’s 
surprising that the article doesn’t quote any outside experts 
on the record.

In response, Apple released a public statement, saying 
bluntly that everything the article claims about Apple is 
completely untrue:

On this we can be very clear: Apple has never found malicious 
chips, “hardware manipulations” or vulnerabilities purposely 
planted in any server. Apple never had any contact with the FBI 
or any other agency about such an incident. We are not aware  
of any investigation by the FBI, nor are our contacts in law  
enforcement.

and

Finally, in response to questions we have received from other 
news organizations since Businessweek published its story, we 
are not under any kind of gag order or other confidentiality 
obligations.

Apple’s statement has none of the tenor of a company 
trying to cover up untoward behavior, and if anything, it 

by Adam Engst

Apple Categorically Denies
Businessweek’s China Hack Report

sounds as though the company is fed up with Bloomberg’s 
questions and allegations. Since then, both the US  
Department of Homeland Security and Britain’s National 
Cyber Security Center have said that they have no reason  
to doubt Apple’s statement. Plus, BuzzFeed’s John 
Paczkowski reported that multiple senior Apple executives 
“all denied and expressed confusion” with the report. And 
Apple has now sent a letter to Congress reiterating these 
denials.

In addition, Apple and Amazon, which also denied the 
article’s scenario, are both $1 trillion public companies that 
routinely face and sometimes lose lawsuits over product 
representations. Their statements are so specific, cover so 
much, and are so definitive that both companies would 
have an enormous liability should it come out that they 
were lying.

Although there have been some suggestions that such an 
attack is technically feasible, our contacts with hardware 
manufacturing experience are extremely dubious that this 
particular one could have taken place as described without 
anyone noticing, and our contacts in security reporting 
haven’t heard anything about this from their sources. So 
we are currently assuming that Apple is telling the truth 
about not having found malicious chips in its servers.

But Businessweek isn’t a fly-by-night publication, and 
there are too many sources quoted and details given for the 
reporters to just be confused. So unless it’s all an elaborate 
fiction that somehow snuck by the publication’s editors, we 
remain unable to explain why Businessweek published the 
piece in the face of such categorical denials.

by Rich Mogull

I saw my first dead body in the fall of 1990. I was 
in Emergency Medical Technician school a couple of 

nights each week and on my first ride with a real ambu-
lance crew in Boulder, Colorado. The guy’s neighbors were 
worried and called 9-1-1. We came and left. We didn’t 
know why or how this man died, just that he appeared to 

I’m a Paramedic: 
Here’s How the Apple Watch Series 4 

Will and Won’t Save Lives

have fallen down due to whatever killed him, and there 
wasn’t anything we could do.

Later on, I finished EMT school, volunteered with a local 
fire department and ambulance, moved on to Paramedic 
school, and spent a couple of years working full-time in 
emergency medical services. Eventually, I scaled back to 
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finish college and spent more time with mountain rescue 
and ski patrol, and on a disaster response team, which I 
still do today.

I’ve seen strokes from atrial fibrillation (AFib), slip and 
falls, mountain biking mishaps, and the usual menagerie of 
human frailty and stupidity. While I worked full-time for 
only a few years, I’ve been a part of the EMS system in one 
form or another for over 25 years.

Thanks to its health monitoring features, the new Apple 
Watch Series 4 will save lives, probably within weeks of 
launch. I’ve been on real calls that might have had happier 
endings had the person been wearing one. I don’t know if 
wearing one would have saved that first victim—probably 
not — but Apple should get full credit for building a 
mainstream device that will save some lives.

That doesn’t mean it’s perfect. The Apple Watch Series 4 is 
far from a comprehensive life-saving device. It suffers from 
some serious limitations and faces some very real obstacles, 
especially cost and battery life, but in the end, some people 
will live longer because they wear one. Over time these  
features will become more reliable, more affordable, and 
more comprehensive, especially as Apple’s competitors 
catch up.

The Apple Watch Series 4’s three key health-related features 
are fall detection, atrial fibrillation detection, and a simpli-
fied electrocardiogram (ECG). Here’s how they might help, 
the limitations they face, and where Apple might go next.

Fall Detection

I responded to countless “slip and fall” calls over the years. 
These are one of the most common calls for paramedics. 
Particularly for the elderly, the consequences of a fall can 
be fatal even when there’s a quick response. Head injuries 
are frequent and serious, but hip fractures are even more 
common and can lead down a path from which it’s very 
difficult to recover.

You can purchase medical devices that monitor elderly 
family members while still giving them personal freedom. 
Anyone of a certain age remembers those “Help, I’ve fallen, 
and I can’t get up!” commercials. Typically, the patient 
needs to activate the device by pressing a button. Many of 
these devices are restricted to home use since they tie into a 
landline.

Life Call Commercial 
“I’ve fallen and I can’t get up!”

The Apple Watch Series 4 works similarly, detecting falls 
with its integrated accelerometer and gyroscope — see 
Joanna Stern’s Wall Street Journal video with a Hollywood 
stunt double for examples. It will then call for help if the 
wearer doesn’t respond to an alert within 1 minute. Since 
the Apple Watch knows when it’s on your wrist, there 
shouldn’t be any false alarms triggered by dropping it on 
your nightstand. It won’t detect all fall scenarios, and  
certainly not non-slip situations like slumping after a 
stroke, but the subset of what it can detect will likely rack 
up immediate saves. It can also work anywhere, not just in 
the home, like previous landline-tied solutions.

If you buy an Apple Watch Series 4 for a family member, 
make sure they wear it in the shower, when they’re most 
likely to have an accident. Yes, it’s sufficiently waterproof.

I’m not worried about there being too many false positives. 
First, it’s on by default only if the user has identified 
themselves as being over 65 in the Medical ID screen of 
the Health app; otherwise you turn it on in the Watch app. 
Second, there is a subset of falling patterns that is pretty 
distinct, and the combination of a fall, no movement for 1 
minute, no response to an audible alert, and no response 
when 9-1-1 calls back should filter most of those out. False 
positives are a fact of the job, and EMTs deploy all the time 
on faulty fire alarms and injury-free car accidents. It 
bothered me only when I had just sat down to dinner.

Unfortunately, not every detected fall will result in a 
positive outcome. But it’s better to have someone respond 
right away than days later.

There are three significant inhibitors to the fall-detection 
feature. The first is cost, especially since all Apple Watches 
need an iPhone companion. That first inhibitor leads into 
the second, which is the complexity of both an iPhone and 
the Apple Watch in a demographic where the primary users 
may also be battling mental degradation. And this second 
issue ties to the third, which is the effort of keeping the 
Apple Watch charged and wearing it consistently. Again, 
this is likely a challenge for the most vulnerable population.

None of these is Apple’s fault; they’re just real-world 
limitations of the technology. The only thing Apple could 
change would be to remove the requirement that the Apple 
Watch be associated with an iPhone.

On the whole, I’m incredibly excited about this feature  
because it will save lives. Sometimes hyperbole is reality.

A Primer on Cardiology and Atrial Fibrillation

Before I discuss the next two features, it will help to 
understand the basics of how the human heart works. I’m 
oversimplifying intentionally—any cardiologists reading 
this article should skip this part to avoid increased blood 
pressure.

The heart has two halves and four chambers. The right side 
pumps blood to the lungs, and the left side serves the rest 
of the body. The top chambers on each side, the atria, are 
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the “staging pumps” that load up the lower chambers, the 
ventricles, that do the real work. Without the atria, the 
ventricles can still move blood, but not as efficiently.

Heart cells are pretty wild and have something called 
automaticity. That means they can generate their own 
electrical signals and contract on their own without relying 
on nerve cells, as do most other muscles. Heart cells will 
beat on their own without external influence. They also 
work like a mesh network and influence the other cells 
around them. To keep everything coordinated, the heart 
has two pacemakers, bundles of cells that send out strong 
electrical signals so all the cells work together and squeeze 
when they are supposed to: the SA node (sinoatrial) in the 
atria, and the AV node (atrioventricular) for the ventricles.

The SA node fires and triggers the atria like the drummer 
in a band keeping time. This signal then shoots down 
special conductive pathways to the AV node, which sends 
a signal out and around the ventricles on different pathways 
to trigger the bigger contraction that moves the blood 
around the body.

Many things can mess up this process, and one of the more 
common is when something happens to the SA node, or 
the cells in the atria stop cooperating and get out of sync. 
That can lead to atrial fibrillation (AFib), where the cells 
of the atria stop working together and start contracting 
randomly. That causes the atria to stop pumping blood, 
leaving the ventricles on their own. While the ventricles 
can keep things moving by working harder—which also 
isn’t good—the worst issue is that blood can pool around 
and coagulate in the atria or the less-filled ventricles. This 
coagulated blood creates a clot, which the ventricles will 
happily shoot off to other parts of the body. If it blocks 
blood to the brain, that’s a stroke.

AFib can also cause weird effects like a dangerously high 
heart rate. Some of those random signals can, in turn, 
confuse the AV node, which is what causes the irregular 
beating of the ventricles, and thus an irregular pulse. If the 
ventricles beat too quickly, that becomes a medical emer-
gency since your heart can only go so fast for so long. The 
high heart rate is also less efficient and further increases the 
chance of stroke.

Ventricles can also fibrillate. But if that happens, blood 
stops circulating, and you’ll die quickly. If you’re lucky, 
you get to wake up after someone yells “Clear!”

Detecting AFib with an Apple Watch

Apple worked with Stanford University on a study to 
refine the Apple Watch’s atrial fibrillation detection. AFib 
characteristically causes an irregular heart rate as those  
random signals hit the AV node or other parts of the ventricle.  
If the atria just stop working at all (it happens) or the ran-
dom signals are blocked, those are different arrhythmia 
(electrical problems), and the AV node and ventricles will 
keep firing their signals at a regular, albeit inherently slower, 
rate.

All versions of the Apple Watch can detect your heart rate 
using special lights on the back of the watch that shine 
into the skin on your wrists. Other sensors detect subtle 
changes in the light coming back and measure differences 
in blood flow which directly correlate to your heartbeat. If 
this approach seems a little sketchy, it is—wrist-based heart 
rate monitors aren’t known for being highly accurate.

However, to detect atrial fibrillation, the exact pulse rate 
isn’t important. Instead, the Apple Watch looks for an ir-
regular pulse, taking into account inherent noise due to the 
watch moving on the wrist or changing light conditions. 
If it detects a pattern of irregularity that matches AFib 
enough times, it alerts the wearer.

Atrial fibrillation is one of the most common cardiac issues, 
especially as we age, and a leading cause of stroke. Unless 
you go into rapid AFib (technically, AFib with rapid ven-
tricular response), you might not know you ever have it. 
Early notification of asymptomatic AFib is a major deal 
since it is a manageable condition. Far more manageable 
than a stroke.

The Value of an ECG on the Wrist

Because the heart sends out strong, coordinated electrical 
signals, they can be detected fairly easily using an  
electrocardiogram, which produces a graph like the one 
below. The basics are easy to read. The first bump is the SA 
node firing—it’s called the P-wave. Then there’s a pause as 
the signal goes to the AV node, where you see a spike for 
the QRS complex, which shows the AV node firing and the 
signal triggering the ventricles to contract. The last bump is 
the T-wave, which shows the ventricles recharging to beat 
again.

My annotated ECG, taken using my iPhone 
and AliveCor’s Kardia device and app.

A traditional ECG measures all this activity with electrodes 
attached to your skin that detect those voltage changes. 
When I first started as a paramedic, we used 3-lead ECGs 
in the field, which let us detect only the most obvious 
arrhythmias. Attaching one lead on the right arm, another 
on the left, and one on the left leg creates something known 
as Einthoven’s Triangle and provides multiple views of 
how the signal moves around. These days we use 12-lead 
ECGs that offer a lot more angles and let us potentially  
detect things like heart attacks.
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Einthoven’s Triangle, which shows the direction in which ECG 
leads read the heart’s electrical signal. Lead I, which the Apple 

Watch Series 4 uses, looks across the top while Lead II more 
closely follows the same vector as the heart.

The Apple Watch Series 4 includes a Lead I ECG, invoked 
by holding your finger on the Digital Crown. It gives a 
decent view of the heart, but Lead II’s data is usually cleaner 
since it captures a better angle that’s more aligned with 
the heart’s conduction path and thus shows the strongest 
signal. Given the inherent limitations of the Apple Watch’s 
sensors, or any single lead ECG, the Apple Watch Series 4 
will only be able to detect basic arrhythmias and perhaps 
some interesting fitness data.

It should be possible to identify AFib because it shows 
up quite obviously on an ECG as a missing P-wave and a 
bunch of squiggly lines as the uncoordinated cells all fire 
on their own. Being able to identify AFib on demand will 
give doctors a much better view than the optical detection 
that sees only an irregular pulse.

However, a Lead I ECG can’t detect a heart attack. It can 
detect some other issues, but many of those require knowing 
things like the exact timing of the distance between the 
P-wave and the QRS complex. I suspect Apple won’t be 
providing warnings of such conditions anytime soon, since 
even experienced medical professionals can miss those 
issues, especially with only a single lead.

I think the most significant immediate value to the Ap-
ple Watch Series 4’s ECG capability will come in refining 
AFib detection and letting doctors better monitor known 
AFib patients. Over time, I’m sure more studies will look 
for additional issues that can be detected with the Apple 
Watch’s Lead I ECG, but they will always be limited to a 
few well-known and major arrhythmias that are both  
detectable and actionable. Ventricular fibrillation, for  
example, is easy to detect but you probably wouldn’t be 
capable of holding your finger on the Digital Crown because 
you’d be busy dying.

Nonetheless, I find the Apple Watch Series 4’s ECG prom-
ising. It will be of most value to physicians keeping track 

of patients with known issues, especially since the optical 
AFib detection is more likely to find a previously undiag-
nosed instance of AFib. Many AFib patients today have 
small sensors implanted into their chests to track their 
issue and call doctors if it gets worse, so clearly there is 
a medical need. It may also be useful in helping patients 
with heart conditions record ECGs during specific events 
and then share those ECGs with cardiologists—most heart 
events don’t take place in the doctor’s office. Over time I’ll 
be very interested to see if Apple can expand the technolo-
gy to detect other arrhythmias, but I wouldn’t expect that 
anytime soon.

A New Healthcare Horizon

The Apple Watch Series 4 is a big deal. Fall detection will 
save lives nearly immediately. AFib detection will help 
reduce the rate of strokes. And the ECG feature will enable 
doctors to better monitor and communicate with their pa-
tients. Even young, healthy, active people will see benefits 
ranging from immediate help after crashing on a bike to 
early detection of congenital or random AFib.

Unfortunately, these features are available only to people 
with the financial means to afford an Apple Watch and 
iPhone, who are cognitively capable of using the devices, 
and who can wear the watch reliably and keep it charged. 
These are serious inhibitors for broad adoption among the 
most vulnerable populations.

However, none of this should detract from what Apple has 
done here. Even if the Apple Watch Series 4’s health-mon-
itoring features are imperfect, even if they detect only a 
subset of issues and incidents, wearing one will allow some 
people to live longer and healthier lives.

Now that Apple has put its stake in the ground, I expect a 
few advancements moving forward.

First, it is likely that more insurance companies will start 
subsidizing or providing Apple Watches to customers. 
Some companies, like Aetna, John Hancock, and United-
Health Group, already do this to get people moving more 
with the health tracking. This should help reduce some of 
the financial overhead. Also, the price will go down over 
time as Apple introduces new versions of the Apple Watch 
and keeps older versions around at a reduced cost. It will 
also take a little time for physicians to hook into the ecosys-
tem and start using its features with patients.

Regarding technology advancements, it’s best to look at the 
vital signs that we healthcare professionals always want: 
pulse, respiratory rate, oxygen saturation, blood pressure, 
and blood sugar (glucose) levels.

Apple has already nailed pulse. Respiratory rate can be 
detected electrically, but probably not on the wrist. There 
have been numerous rumors about solutions for the last 
three, and the latest devices from Garmin claim to be able 
to detect oxygen saturation. When combined with pulse 
detection, low oxygen saturation readings could help 
identify sleep apnea, which is another major indicator of 
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long-term health issues. Like AFib detection, detecting 
sleep apnea has the potential for large quality of life 
improvements. I wouldn’t be surprised to see something 
along those lines within the next two revisions of the Apple 
Watch.

Blood pressure is also a key indicator of a wide range of 
health issues, especially stroke. Despite all the rumors, I  
haven’t seen enough science to indicate we are close to 
being able to detect it without inflatable cuffs. That’s a big 
tech problem that Apple is probably working on, but one 
that may not have a wrist-based solution.

The same goes for glucose levels, which are critical for 
managing diabetes. Right now, the only reliable  
measurement techniques require small blood samples.  

Accurate detection with a watch would be a massive  
scientific breakthrough with lasting social impact. But 
again, it’s not something we can predict.

Even without these additional features, the Apple Watch 
Series 4 encourages a more active lifestyle, can detect the 
early onset of a potentially debilitating heart disease, and 
can call for help during certain life-threatening accidents. 
These are huge advancements that will improve and extend 
lives. Even in my limited personal experience, I know of 
real-life incidents that might have had a far better outcome 
had the individuals involved worn Apple Watches. I’ll be 
buying some for certain family members this year, and 
even knowing the limitations of the device, I’ll sleep better 
for it.

Do you find your Mac’s screen too bright for comfort, 
even after you’ve dropped the brightness setting 

in System Preferences > Displays? Apple has been sensitive 
to lighting issues for years, enabling the Mac to adjust 
screen brightness automatically to match ambient light and 
adding Night Shift to shift the colors of the display after 
dark. On the MacBook Pro, even the keyboard is backlit for 
easier typing in the dark, and it too can adjust its brightness in 
low light. And in previous versions of macOS, there was an 
option to make the menu bar and Dock dark.

More significant than these options, though, is macOS 
10.14 Mojave’s Dark mode, the first major visual change in 
macOS in a long time. Apple promotes it generally, saying:

Dark Mode is a dramatic new look that helps you focus on your 
work. The subtle colors and fine points of your content take 
center screen as toolbars and menus recede into the background. 
Switch it on in the General pane in System Preferences to create 
a beautiful, distraction-free working environment that’s easy on 
the eyes — in every way.

It’s not clear that Dark mode is a win for everyone, but 
light-sensitive people such as Josh are thrilled by Dark 
mode because it radically reduces the amount of light 
coming from the screen.

Dark mode is easy to turn on and off in System Preferences  
> General, where you can click Dark or switch back to the 
traditional look with a click on Light. There’s no shortcut 
for switching, but developer Benjamin Kramser has just 
released NightOwl, a menu bar utility that makes switching 
easy and also provides a schedule for automated switching, 
much like Night Shift. That might be helpful if your work 

Explore the Dark Side of Mojave: 
Understanding, Enabling,  

and Customizing Dark Mode

by Adam Engst & Josh Centers

environment is light during the day, but dark at night, 
when a bright screen may be less comfortable.

When you switch into Dark mode, macOS immediately 
swaps dark text on light backgrounds for light text on dark 
backgrounds, changing the menu bar, windows, interface 
elements, and more in the Finder and supported apps. As 
you can tell by the increased number of releases in our 
Software Watchlist, developers have jumped on Dark mode 
with enthusiasm, so nearly every app that claims Mojave 
compatibility is specifying support for Dark mode. Older 
apps won’t gain Dark mode support without an update.

Josh has made a video showing how to turn it on, and 
offering some examples of how it looks. Even though not 
every app supports it, it still makes a big difference!
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Precisely what aspects of an app get dark is another ques-
tion, however, and this is one of Dark mode’s challenges. 
Open a new document in TextEdit or Pages while in Dark 
mode, and while the toolbar and controls will all be dark, 
the content area will be the same bright white that it always 
was before. Same with Safari and many Web sites. Worse, 
the contrast between a bright content area and dark controls 
is more jarring than when the controls were on a light  
background. Help may be available from Denk Alexandru’s  
Dark Mode for Safari, a $1.99 extension for Safari that gives 
you control over Web site themes.

Some apps have their own internal settings specific to Dark 
mode that let you pull back on how dark it is. For instance, 
when you’re in Dark mode, Mail displays a new “Use dark 
backgrounds for messages” checkbox in Settings > General 
that lets you choose between dark and light backgrounds 
when reading and composing messages. Similarly, when 
running Maps in Dark mode, you can choose View > Use 
Dark Map to switch the map style between the standard 
light style and a dark style. You’ll have to poke around in 
your favorite apps in Dark mode to see if they offer such 
adjustments.

Another challenge for Dark mode is that light text on a 
dark background doesn’t have nearly as much contrast, 
so it’s harder to see, particularly for the majority of the 
population that isn’t light-sensitive. If you find reading 
text in Dark mode difficult because it seems blurry, but you 
prefer the dark look otherwise, you may be able to make it 
more to your liking by changing the font or style to make it 
bigger or bolder, such as in Mail’s Settings > Fonts & Colors 
settings. For system-wide improvements, though, visit  
System Preferences > Accessibility > Display.

The Display Contrast slider here lets you make text whiter 
and backgrounds dark, which goes a long way to improving 
the readability of text. Select Reduce Transparency to make 
items like the Dock and menus solid, rather than allowing 
the background to show through slightly. And to separate 
dark and light even more, select Increase Contrast—it turns 
up the brightness on divider lines as well, which can make 
windows easier to interpret.

Finally, if you’re using Dark mode, you’ll probably want a 
dark desktop picture to keep the overall screen brightness 
down and avoid too much contrast with the dark windows 
and controls. If you look in System Preferences > Desktop 
& Screen Saver, you’ll find new wallpapers that won’t blow 
out your eyes.

Should you give Dark mode a try? Absolutely! It’s trivial to 
turn on and off again and has no lasting effect on anything 
apart from your retinas. Most people aren’t light-sensitive, 
and for them, especially during the day when room lighting 
is generally quite bright, the traditional look will likely be 
the most comfortable and easiest to read. However, if you 
recoil in pain from too-bright screens, particularly in dimly 
lit rooms, Dark mode may be a boon for your eyes. And if 
you have no issues with either the light or dark look of 
macOS, feel free to pick whichever you prefer aesthetically.
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How to Take Photos and Scan Documents 
with Continuity Camera in Mojave

SHARE

One of the cool things about living in the Apple 
ecosystem is how your various Apple devices 

can interact with each other through Continuity, which 
includes features like auto-unlocking your Mac by wearing 
your Apple Watch, automatically moving copied text 
across devices, sharing files via AirDrop, and taking calls 
anywhere with Wi-Fi Calling.

In macOS 10.14 Mojave, Apple has expanded these  
capabilities with Continuity Camera, a new feature that 
lets you take pictures or scan documents with an iOS 12 
device and have them immediately show up on your Mac — 
either on the Desktop or in a document. If you’ve ever been 
working on your Mac and needed to email someone a scan 
of a receipt that’s sitting on your desk, you’re going to love 
Continuity Camera.

Requirements and Controls

As with many system-level features, Continuity Camera 
requires explicit support in apps. Unsurprisingly, many of 
Apple’s apps offer Continuity Camera in Mojave, including 
the Finder, Mail, Messages, Notes, TextEdit, Pages, Keynote, 
and Numbers. I haven’t yet heard of any third-party apps 
that have added support, but let us know in the comments 
if you run across any.

Continuity Camera has a few basic requirements: the Mac 
and iOS device need to be on the same Wi-Fi network, 
have Bluetooth turned on, and they must be logged in to 
the same Apple ID, which must be set up with two-factor 
authentication. Check the Apple ID on your Mac in System 
Preferences > iCloud and in iOS under Settings > Your 
Name.

How you access Continuity Camera varies somewhat by 
app, but the most common way is to Control- or right-click 
where you want the photo or scanned document to appear. 
If you have only one device, you will see a subhead for the 
device, like iPhone X, above commands for Take Photo and 
Scan Documents. If you have multiple devices, you’ll see 
an “Import from iPhone or iPad” submenu, under which 
those commands will be replicated for each device.

In many of Apple’s apps, you’ll also see Import from iP-
hone as a submenu in the File menu, although that sub-
menu moves to the Insert menu in Pages, Keynote, and 
Numbers. Plus, in Mail composition windows, there’s a 
drop-down menu on the right side of the toolbar that in-
cludes the Take Photo and Scan Documents commands.

For simplicity’s sake, I’m going to focus on importing im-
ages to the Desktop, but the process is the same regardless 
of whether you’re in the Finder or some other app. If you’d 
like to watch a quick visual guide to Continuity Camera, 
check out my short video that explains how to use it.

Take Photos with Continuity Camera

Here’s how to take a photo with Continuity Camera:

Control-click the Desktop, and in the contextual menu, 
choose Import from iPhone > Take Photo.

A dialog or popover (the latter in apps) appears on the 
Mac screen, and a simplified version of the Camera app 
opens on your iPhone. You don’t get many options, 
but you can switch between the front- and rear-facing 
cameras, and tap the flash icon to turn the flash on or 
off, or set it to auto (the default). You can also pinch 
out to zoom or tap the 2x button on an iPhone with 
two rear-facing cameras.

Frame your subject in the viewfinder, and tap the shutter 
button.
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– macOS Mojave 10.14

The macOS Mojave 10.14.1 update improves the stability, 
compatibility and security of your Mac, and is recommended 
for all users.

This update:

Adds support for Group FaceTime video and audio calls, 
which support up to 32 participants simultaneously, are  
encrypted end-to-end for privacy, and can be initiated 
from a group Messages conversation, or joined at any time 
during an active call.

Adds over 70 new emoji characters, including new  
characters with red hair, gray hair and curly hair, new  
emoji for bald people, more emotive smiley faces and  
additional emoji representing animals, sports and food.

�

�

Tap Use Photo to save the photo to the Mac’s Desktop 
as a JPEG.  Or if the photo isn’t to your liking, tap  
Retake to try again. Note that the photo won’t appear 
in Photos on your iPhone.

Scan Documents with Continuity Camera

For most people, document scanning with Continuity 
Camera is more useful than taking photos, since you’re  
unlikely to need a one-off photo that you can take while 
sitting near a Mac. Be sure to have your document ready 
on a well-lit surface, and then follow these steps:

Control-click the Desktop, and in the contextual menu, 
choose Import from iPhone > Scan Documents.

You see a dialog or popover, and a Camera app variant 
opens on your iPhone. This one offers a few more  
options than Take Photo:

Flash: Tapping the flash icon lets you lock the flash on  
or off. The default is auto.

Filters: Tap the Filter icon to choose which sort of scan 
to take: color, grayscale, black-and-white, or photo. 
The default is color.

Auto: By default, the scanner will snap a picture  
automatically when it detects a document, but  
tapping Auto lets you change that to manual.

Once your options are set, center the document in the 
viewfinder, and if Auto is enabled, the iPhone will 
capture the image automatically.

If you’re capturing the document manually, tap the 
shutter button. Drag the four circles to adjust the  
corners if necessary.

If the scanner captured an image you didn’t want (as 
happened in my video), tap Retake to go back.

Tap Keep Scan to add the scan to your queue.

For a multi-page document, you can continue scanning 
subsequent pages. Each additional scan is added as 
an extra page to the document. When you’re done, 
tap Save to transfer your scans to your Mac as a PDF. 
The scanned document is not saved on the iPhone.

It’s tempting to import directly into apps, and for a quick 
photo or single-page scan, that should work well. However, 
you might prefer to import photos and scans to the Desk-
top first, and then drag them to their eventual destination. 
That approach gives you another copy of the file, which 
may provide more flexibility or security—you never know 
when you’ll need a photo or scan again. As with many 
Continuity features, Continuity Camera can be fussy. Its 
contextual menu commands sometimes disappear, presum-
ably due to communication lapses. Once when I was scan-
ning, tapping the Save button did nothing — this might 
have been an indication of a communication failure. And 
another time, it just threw up its hands.

Nonetheless, we’ve found Continuity Camera to be among 
the most useful features of Mojave. Although we’re still 
recommending that most people hold off on upgrading to 
Mojave, once you take the leap, be sure to give Continuity 
Camera a try!

Software Review
Security Update 2018-002 (High Sierra)
Oct 30, 2018 – 421.1 MB
System Requirements

– macOS 10.13

Security Update 2018-002 is recommended for all users  
and improves the security of macOS.

Security Update 2018-005 (Sierra)
Oct 30, 2018 – 421.1 MB
System Requirements

– macOS Sierra 10.1

Security Update 2018-005 is recommended for all users  
and improves the security of macOS.

macOS Mojave 10.14.1 Update
Oct 30, 2018
System Requirements


